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Work with computers
1 hour 9 minutes
This learning path will introduce you to the different parts and types of the computer and their functions. You will also learn the difference between operating systems and applications and their functions. Peripherals and portable storage devices will be discussed as well. 
To complete this course and receive your certificate, you must visit every page of this course.
[bookmark: _Hlk24726218]Interact with a computer
11 minutes | 6 units
In this module, you will explore what a computer is, the parts of a computer, and how to interact with it.
Introduction
1 minute
There are many types of computers that are used for everyday tasks.
In this lesson, we'll explore what a computer is, the parts of a computer and how to interact with a computer.
By the end of this lesson you will be able to:
· Describe the functions of a computer.
· Differentiate between computer hardware and software.
· Describe the primary parts of a computer and the use of each part.

Describe the functions of a computer
1 minute
What is a computer
Nowadays, computers are everywhere, and we are using them for a variety of tasks. There are various types of computers that have changed how we live in many ways.
Watch the following video to learn more about computers.
Video: What is a computer
Computers are now used everywhere around us. You will find them at work, in stores, in hospitals, and at home. 
A computer is an electronic machine that can process, store, and retrieve different types of data and information. You can use the computer to perform many tasks such as writing documents, playing games, sending emails, learning new skills, browsing the web, and watching movies. All computers consist of two main parts, hardware and software. 
Software refers to the intangible parts of a computer, the parts that can't be touched. This includes the instructions that control how the hardware functions, the applications running on the computer, and the data stored on the computer. 
Hardware includes all of the physical parts that make up a computer such as the monitor and the central processing unit, that keeps data moving. There are various types of computers that you may encounter, but they all share the same fundamental purpose of processing and storing information.
Describe the primary parts of a computer
2 minutes
Parts of a computer
A computer consists of many hardware components. Although there are various types of computers, all computers contain a similar set of hardware parts. Each of these hardware parts helps us use and interact with the computer in some way.
Watch the following video to learn about the hardware components that make up a computer.
Video: Parts of a computer
Let's take a look at the primary hardware components that make up a computer. This includes the base unit, the monitor, the speakers, the keyboard, and the mouse. Each part serves a purpose that allows us to operate and interact with a computer. 
The base unit holds the brains of the computer, the physical parts that process information and make the computer function. It contains important components like the CPU or Central Processing Unit, the motherboard, the hard disk, and the memory units. It also contains ports that allow you to plug additional components or devices into your computer, like headphones or a printer. 
The monitor, sometimes referred to as the display, is the part of the computer that displays output for users to view, like graphics and text. In some cases, the monitor is a separate piece that you must physically plug into your computer. In other cases, the monitor is built into the computing device. 
The speakers allow you to listen to sound that comes from the computer. In some cases, the speakers are built into the computer. In other cases, you must physically connect speakers to your computer in order to hear audio. 
The keyboard is an input device used to interact with a computer. Using a keyboard, you can type letters, numbers, and characters that will be processed by the computer. Keyboards can be physical and attached to the computer, or they can be virtual, where you use a touch display to type by directly touching the screen of the monitor. 
The mouse is an important device used to interact with items displayed on the screen. When you move the mouse, a pointer on the screen also moves, allowing you to operate the computer. You can plug a physical mouse into your computer or use the touch pad that is built into some computers and provides the same function. 
All of these parts may not look the same for every type of computer, but they still provide the same functions.
Describe the various types of modern personal computing devices
3 minutes
Types of personal computers
Computers come in many shapes and sizes. Each type has its own advantages and disadvantages that make it suitable for certain uses and scenarios.
Watch the following video to learn about the types of personal computers, their differences, and their uses.
Video: Types of personal computers
Computers come in many forms. Some of the most common types are desktop computers, laptops, and mobile phones. But other types of devices such as calculators, gaming consoles, and smart TVs are also computers. 
The types of computers that we use in our daily lives are called personal computers. Let's look at some of the most common types of personal computing devices and their uses. A desktop is a personal computer designed to stay in one place like on top of a desk. A desktop computer typically has separate pieces for the base unit, monitor, speakers, keyboard, and a mouse. These parts must be connected using cables. Desktop computers must be plugged in to a power source. 
A laptop is a portable personal computer, where all parts of the computer are contained in one device. Laptops contain a built-in processing unit, monitor, keyboard, speaker and mouse touchpad. Laptops are battery powered. So, they do not always need to be plugged into a power source. This makes them easy to be used on-the-go. 
A tablet is another type of portable personal computer. The computer parts that make up the tablet are contained in a single device; it is smaller than most laptops. Typically, the size of a book. Because of their small portable size, tablets are often used for entertainment activities like watching movies or playing games. You can install software applications on tablets that allow you to perform various tasks.
A smartphone is a common type of portable personal computing device, that is small enough to be handheld. The primary use of smartphones is to make phone calls using mobile networks. But they can be used for much more. You can use a variety of software applications on your smartphone that allow you to take photos, play games, browse the web, send emails, read documents, and more. 
These apps are great for on-the-go scenarios. But they are typically a lot more basic than the apps you can install on your desktop or laptop computer. Depending on your needs, there are a variety of personal computing devices that you can use to get things done.
Knowledge check
3 minutes
1. Which of these devices is not a computer?
· A desktop
· A laptop
· A tablet
· A monitor - Correct! A monitor is not a computer.

2. Which of the following parts of a computer is considered as input device?
· Speakers
· Screen
· Keyboard - Correct! A keyboard is an input device.
· Motherboard

3. Harold needs to purchase a computer as they’re starting university. What they want is a computer with a built-in keyboard to type their lecture notes, and to work on their assignments at home. They’ll also need various applications and programs installed on the computer to complete their assignments. What is the best type of computer for their needs?
· A desktop
· A laptop - Correct! A laptop is a portable device with built-in keyboard.
· A tablet
· A smartphone

Summary
1 minute
Congratulations!
You have completed the Interact with a computer module and now can answer the following questions on your own:
1. What are the primary functions of a computer?
2. What is the difference between computer hardware and software?
3. What are the primary hardware parts that make up a computer?
4. What are the common types of personal computing devices?
Use a computer
36 minutes | 11 units
In this module, you will learn about operating systems and how to use the basic functions of the Windows 10 operating system.
Introduction
1 minute 
In this lesson, you will learn how to operate a computer to perform basic tasks.
By the end of this lesson you will be able to:
· Describe the role of an operating system.
· Navigate the Windows 10 operating system.
· Organize files and folders in Windows 10.
· Use the right-click to access system features.
· Customize your operating system desktop.

Describe the role of an operating system
2 minutes
What is an operating system
The operating system is the conductor of the computer. It coordinates the software and hardware parts of the computer, making sure all of the different components work together to get things done.
There are many operating systems provided by many companies in the world. Each operating system is designed to work on specific types of devices. For example:
· Windows is designed by Microsoft. It is a family of operating systems that can run on a variety of PCs and laptops. We will use the Windows 10 version of this operating system for demos in this course.
· MacOS is designed by Apple Inc. and works on Apple's Macintosh computers like the MacBook.
· iOS is designed by Apple Inc. and works on Apple's mobile devices like iPhone, iPod, and iPad devices.
· Android OS is designed by Google and works mainly on touchscreen mobile devices like smartphones and tablets.
· Google Chrome OS is designed by Google and works on Chromebook devices.

Watch the following video to learn about operating systems.
Video: What is an operating system
Computers are tools that allow us to get things done electronically. To use a computer for our tasks, we need to be able to tell the computer what we want it to do. Operating systems make this possible. 
The operating system, sometimes called the OS, is the main piece of software that runs in a computer. The operating system manages all other software and hardware parts of the computer and provides a way for you to communicate with the computer. Modern operating systems are designed with graphical interfaces containing icons, buttons, and texts that make it easy for people to use the computer. You can even customize the look and feel of your operating system, so that it's easier for you to use in the way you'd like. 
Consider that you want to use your computer to create a text document. You can use the graphical menus and buttons within the operating system to create the document, use the keyboard to enter text into your document, and tell the operating system to save your file. The operating system handles all of the physical tasks behind the scenes, like keeping track of what you typed on the keyboard, controlling the processor, and saving your information to the hard drive. 
There are different types of operating systems for different types of computers. Many PCs run the Microsoft Windows operating system, while Mac computers run the Mac OS system, and some computers run the Linux operating system. Mobile devices run different operating systems than laptops and desktop computers. 
When you purchase a computer, the operating system for that device is usually pre-installed for you. Operating systems make it possible for us to operate computers and get things done.
Navigate the Windows 10 operating system
7 minutes
Get to know the operating system
Let's explore the basics of working with an operating system. We'll use the Windows 10 operating system for examples, but these concepts carry over to other operating systems too.
Watch the following video for an overview of the Windows 10 operating system.
Video: Navigate your OS
Windows 10 is the latest version of Microsoft's operating system for PCs and tablets as well as many other devices. Windows comes pre-installed on most new devices. In this video, we will explore the basics of working with an operating system. We'll use the Windows 10 operating system for examples. But these concepts carryover to other operating systems too. 
When you start up your Windows 10 device, the first thing that will load is the operating system. You will see a screen asking you to log in. A device using Windows 10 as the operating system can be used by more than one person or user. Each user would create their own username and password, then use them to log into their profile and access their own documents without seeing other user's documents or profiles. This allows each user to create their own profile and personalize their experience the way they like. 
For instance, imagine two users that use the same Windows 10 computer. One user might want their device language to be English. While the other might like it to be Arabic or another language. This is possible with Windows 10 devices. 
To log into your device, simply enter the username and password in the designated boxes. If you've set up a personal identification number or pin when you set up Windows 10, you could use your pin instead of your password when logging in. Then click the arrow next to the password box or simply press enter. If you use your pin, once the correct pin is entered successfully, it will immediately take you to your desktop. 
When you log into your Windows computer, the first thing you see is your desktop. Sort of like the desktop of an actual desk. The desktop is where you can put documents that you're currently working on or documents that you need quick access to. Windows allows you to customize the look of your desktop, like the colors and the background image, which is called the wallpaper. That is why your device desktop might look different than mine here. 
At the bottom of the Windows 10 desktop, is the taskbar. It is a very important component of Windows 10.Within the taskbar, you can accomplish many tasks, such as using the taskbar to know what apps are currently open, finding out what time it is, managing your calendar, pinning your favorite apps to the taskbar so you can easily launch them and more. 
Let's take a closer look at the taskbar. On the far left, you will find the Start button. When you click or tap this button, it opens the Start menu. The Start menu is where you can find all the applications on your device as well as access functionalities like logging off, restarting, and shutting down your device. 
We'll revisit the Start menu shortly. Right next to the Start button, is the search box. It allows you to search for applications by their name or search for files and documents on your device. Just start typing the name of your application or document, and you will find Windows showing you results as you type. You can also find a small microphone icon at the right end of the search box. This is Cortana. 
This section of the taskbar has icons for applications that are pinned to the taskbar, as well as software applications that are currently open or running on your device. Running applications will have a visual line under the application icon to indicate that it's currently running. You can customize this section by removing or adding applications as you see fit. Usually, applications you use frequently are pinned to the taskbar for ease of access. Microsoft Edge and Outlook are good examples of programs that are usually pinned to the taskbar. 
The last section of the taskbar features the date and time section and other icons which vary from one device to another. The clock will show you the current time and date. if you click on the clock, a window will open up revealing your calendar for the current month. 
Other icons in this section of the taskbar include the speaker icon, which allows you to adjust the volume of your device sounds. Click on this icon to adjust your volume by moving the slider to the left or right. The network icon which shows if you are connected to the internet and Wi-Fi. Clicking it will show your local wireless networks, and right-clicking it gives you the option to troubleshoot your connection or open the Network & Internet settings. 
If you have any windows notifications, you can view them by clicking the notifications icon here. You may also have other icons hidden away here, so they don't clutter up the right side of your taskbar. Click the arrow to view your hidden icons. Let's move back over to the left and explore the Start menu in a little more detail. 
Clicking the Start button reveals the Start menu. Here, a list of applications is listed on the left side, while on the right you will see an arrangement of tiles. Tiles are a concept that newer versions of the Windows operating system use, and they are meant to provide another easy way to access your favorite applications quickly. 
You can rearrange the tiles on your Start menu very easily. To move a tile, click and drag it to the desired location. To make a tile bigger or smaller, right-click the tile, select ''Resize'', then choose the desired size. Located within the Start menu are options for quickly accessing your documents and pictures, as well as a quick way to open your Settings menu. Also located here in the Start menu are shortcuts to logging out of your Windows 10 device, shutting down the device, or restarting it. 
To log off your Windows device, click the ''Start menu'', click on your username or avatar, and then click ''Sign out''. One thing about signing out of Windows. 
Signing out is different than shutting down or turning off the computer. Signing out keeps your device running but signs you out of Windows 10. After you log out, the computer is ready for another user to log in. Shutting down your computer simply means you're completely turning off your computer, like you turn off a television or another device.
It is important to shut down your computer correctly, so you do not lose unsaved work. It also allows the operating system and applications to remain healthy and operate normally. 
To shut down your computer click the Start menu and choose ''Power'', then select ''Shutdown''. Sometimes you will need to restart your computer, like when a new application is finished installing on your computer or when an update has been downloaded. A restart is basically a shutdown followed by starting it back up all in one step. Your device will prompt you when it needs to be restarted. 
To restart your device, click on the ''Start'' button, then choose ''Power'', then ''Restart''. As you can see, there is a lot your operating system can do for you so you can use your computer to get things done.
Try it yourself
Challenge: Open the calculator application on your computer.
Organize files and folders in Windows 10
4 minutes
Work with files and folders
Operating systems are designed to help us work in ways that we're used to. Just as we work with physical documents, we can create files and folders to store information on a computer.
Watch the following video to learn how to work with files and folders on your computer.
Video: Work with files and folders
Whatever the reason you need a folder, creating them is easy. Let's start by opening File Explorer. You can either find it in your task bar or you can search for it in the search bar. I want to create a new folder for some of my business documents. So, I will create a folder called Business, and since I want to find it easily, I will create it inside my Documents folder. 
Here, I go to the top and click the "Home" tab, and then select "New folder". A new folder will appear in the list below. Notice the name of the folder is highlighted. Windows now wants me to rename the folder, what I would like it to be called. Click within the name, select all of New folder, and then rename the folder, Business, and click "Enter". There is my new folder. 
Now that I have my new folder, how do I create a file? To do this, let's go back into that new folder I just created. Once in the folder, again go to the "Home" tab and select the "New" item drop-down list. We're now presented with the selection of new types of files we can create. 
Once we select one like Microsoft Word Document or Text Document, it will create a document in your folder. Once it is created like when we created the new folder, it is waiting for you to rename the file. Let's say I'm an author and thinking of writing a new book, and I want to create a list of types of book I may write. So, let's call this file, "Book Ideas." Now that the file is created, we can open it and edit it. 
Okay. So, I may have named that file wrong. Instead of book ideas, I should have named it Book Types. So, now I need to rename the file. To do this, just find the file in the folder and click it. Then go to the "Home" tab and select "Rename". Now, I can rename it. Now that I think about it, I created that file in the wrong folder, it should have been created in a folder I've already created called New Book, so, let's move into that folder. To do this, select the file, go to the "Home" tab, and select the "Move to" drop-down list. 
There are several selections of where we may want to move that file. The folder I want to move it to is not listed. So, I can select "Choose location". There is my folder, select it and click "Move", and it disappears from the current folder, and here it is in the new folder, that was pretty easy. Actually, I like it back in that other folder better. 
Another way to move files is to drag and drop them. To move this file back into the other folder, click and hold on the file then drag it to the new folder, then, let the mouse button go to drop the file into the new folder. Now that I think about it, I'm not an author. So, I shouldn't be writing a book after all, no one would buy it. So, let's delete that file. If you do not need the file anymore and would like to delete it or throw it away, simply select the file, go to the "Home" tab, and select "Delete". There, the file is gone, but don't worry. 
Now you know how to create files and folders, rename them, move files from one folder to another, and delete files.
Try it yourself
Customize your file explorer view.
1. Open the file explorer on your computer.
2. Change between the various view options (use the View menu).
3. Choose the view you prefer.

Use the right-click to access system features
3 minutes
Understand the right-click
Computer hardware and software work together to help us use the computer effectively. One example of this is the mouse and the operating system. We use the primary left-click button of the mouse to perform most operations on the computer. The right-click button has helpful functions that help us access additional features of our software.
Watch the following video to learn more about the right-click and its functions.
Video: Understanding the right-click
When you're using your mouse right-clicking makes it easier and faster to do certain tasks on your computer. First off, what is the right-click? As you know, the left button of the mouse is the primary action button. When selecting an item, clicking a link, clicking, and dragging an item etc., the left button is always the button you use. But the right mouse button is used to access special menus. 
Each type of component on your computer will have a slightly different menu of options when right-clicking. One use of the right-click is when you're working with files. For example, instead of navigating to the file manager home menu to delete a file, you can right-click on the file and scroll down to the "Delete" option. 
It's useful to check the menu for items you're working with. There are often a lot of helpful actions you can access by right-clicking on something. When you right-click on a file for instance, besides having the option to delete it you can also copy it, open it, rename it, move it, etc. We can also view the properties of a file and learn much more about it. Hover over the file, then right-click and select "Properties. "Here we're given information about the file: its current location, what kind of file it is, the size of the file, when it was created, when it was last modified. 
This type of information may be helpful for you sometime in the future and now you know exactly how to find it. You can also right-click inside of a folder to access a different menu of options. 
For example, here you can create a new file or folder inside of the folder you're already in. You can also view the properties of the folder and customize the way files are viewed in the folder. Keep the right-click option in mind when you're working within Windows 10 and see what options you have access to. They could help you work more efficiently.
Try it yourself
Right-click anywhere on your desktop. What options are available? What do you think these options can be used for?

Organize windows
4 minutes
Work with windows
As you use an operating system, you will often be working with many different things at once. The operating system keeps different activities in different views, called "windows."
In this video, you will learn about application windows and how to deal with them.
Video: Work with windows 
As you use your computer, you will usually work within different views that we call windows, in fact that's why we call it Windows. In this video, we're going to explore what windows are and how to use them within the Windows 10 operating system. Any application or program that we open and view in the operating system is a window. 
Here, I will open File Explorer. That is a window. I will open Microsoft Edge as well; there is another window. These two programs or windows operate independently from each other. They can be moved around anywhere you want them to reside on your desktop. This is pretty cool, but it's just the beginning. 
Sometimes whether you're in Word or Microsoft Edge or any other application, you may need the application to take up the entire screen. This is very easy to accomplish. Inside your window, click on the "Maximize" button in the top right. Now the window takes up the entire screen. If that's a little too large of a window, you can return it to the size it was before by clicking the "Restore" button. 
Let's say I'm done tinkering with the files in this folder for now, but I need to have the files close by because I will need one of these files later. Instead of closing the window completely, you can minimize the window by clicking the "Minimize" button in the top right. That will place the folder in the taskbar at the bottom of the desktop. 
To reopen or restore the window, simply find the icon of the window you minimized and click it. Now here is where it gets interesting. If I need to have two applications open at the same time, let's say I'm researching and writing a report and I need Microsoft Edge and Word open, there is a very handy way to make sure they are open to the same size and do not overlap each other. 
Let's open Word and create a new document, then click on the top of the window and drag it to one side of the desktop. Once you see the highlight here, let go of the mouse button and the window snaps to that half of the screen. 
Let's now open Microsoft Edge and drag it to the other side of the desktop and drop it. Now, they both have half the screen and it's easy to go back and forth between them. You can also use this method to work between the two open windows. 
Let me open two folders, I will open files and place it over here to the right, then I'll open more files and place it to the left .I need to move some files from one folder to the other; having both windows open, makes this very easy. Just drag and drop the files in to the other folder, it's that easy. Knowing how to work with windows, will make it easier for you to get things done on your computer.
Customize your operating system desktop
4 minutes
Personalize your desktop
There are many features and settings that you can customize within your operating system based on your preferences. These personalization’s can make it easier for you to get things done on your computer.
[bookmark: _Hlk24720981]Watch the following video to learn how to customize your operating system preferences.
Video: Personalize your desktop
To be more comfortable while using your computer, you can customize the settings of various aspects of your operating system. Let's take a look around. 
To find the personalization menu, first click the Start button to open the Start menu, then select Settings, within Settings, select Personalization. Within this menu, you can personalize your Windows 10 experience a great deal. 
For this video, we will concentrate on some of the more popular ways to customize Windows 10, background, colors, the lock screen, themes, and the taskbar. First, we will personalize the background, to do this click "Background." We have a choice between picture, which is what I have now, solid color. and slideshow. Solid color is exactly that, changing your background to a solid color. You have many to choose from or you can select a custom color. If you have photos in your pictures folder or anywhere else on your computer, selecting slideshow would randomly display photos from that folder as your background. For now, I think I will go with the blue windows logo as my background. 
Colors lets you really customize aspects of your experience with whatever colors you like, you can let Windows automatically select the color from the background image you're currently using, or you can select your favorite color from the large selection below. Also, here in colors, you can choose if you want the taskbar and Start menu to feature the color you've chosen, as well as choose whether you want your apps to appear in light or dark mode. 
You can also customize your lock screen; this is the screen you will see when you log into Windows 10. You can select from Windows photos or use one of your own. You can also choose slideshow and it will randomly display photos from a folder you choose every time you visit the lock screen. 
Themes are groups of background images, colors, sounds, et cetera, that make up a specific experience within Windows. There are some pre-loaded themes to choose from or you could find more themes in the Microsoft store. Within a theme you can also choose to change one aspect of the theme to suit your taste. For instance, I like this theme, but I would love the color to be a little brighter. There, that's more like it. 
Lastly, there is the taskbar. Within this customization menu, you can lock or unlock the taskbar, you can have the taskbar hide from view until you need it for something, you can make the icons in the taskbar smaller, this really helps if you've loaded your taskbar with shortcuts to applications. And if you want you can move the taskbar itself to the right, to the left or even to the top of the screen. 
When you're using your own computer, being able to customize your settings can make using Windows 10 easier and fun.
Try it yourself
Challenge: Modify the preferences on your computer to change the color scheme to a theme of your choice.
Interact with a virtual assistant to complete basic tasks
4 minutes
Use virtual assistants—Cortana
Virtual assistants are digital services that help you to perform tasks on your computer, like setting reminders, checking the weather, and searching the web. Virtual assistants are built into the operating systems of many modern devices. Some of the most popular virtual assistants are Microsoft Cortana, Apple Siri, and Google Assistant.
Virtual assistants use AI or artificial intelligence to learn more about you, so they become more helpful the more you continue to use them. You can use virtual assistants on your desktop, laptop, tablet, smartphone or other supported devices such as smart speakers. To make interactions easier, you can often interact with virtual assistants using voice commands.
Watch the following video to learn how to use the Cortana virtual assistant on a Windows 10 computer.
Video: Use Cortana with Windows 10
Narrator: Cortana is your digital assistant built into Windows. She will help you get things done. The more you use Cortana, the more personalized your experience will be. 
To get started using Cortana, type a question in the search box or select the microphone icon and talk to Cortana. Keep in mind that you need a microphone in order to talk to Cortana. 
First off, I'm always working on my computer and sometimes lose track of time, but I also need to prepare dinner for my family tonight. Cortana can help remind me of that. So, I click on the microphone icon and say, "Set a reminder to make dinner at 5:00 PM. "Cortana: All right. I'll remind you to make dinner at 5:00 PM today. Sounds good? Narrator: Yes. Cortana: Got it. 
Narrator: Okay. So, I have that taken care of, but I have a lot of things going on. I need to go and pick up my kids from the bus stop in about 20 minutes. So, I will set an alarm with Cortana, and she will let me know when to head at the bus stop. Click on the microphone icon and say, "Start timer for 20 minutes. "Cortana: I'll start your timer for 20 minutes. 
Narrator: There are several things Cortana can do for you. They include: give you reminders based on time, places, or people; track packages, teams, interests, or flights; send emails or texts; manage your calendar and keep you up-to-date; create and manage lists; and open any app on your system. Also, you do not even need to click on the microphone icon to communicate with Cortana. Let's go into Cortana settings by clicking the search bar and selecting the gear icon. Once in the Cortana settings, select "Talk to Cortana". Now, let's enable Hey Cortana. Once we do this, we can communicate with Cortana just by saying, "Hey Cortana. Let's try it out. Hey Cortana. Show me photos of pugs. "Cortana: I pulled up some images for you. 
Narrator: Since I'm responsible for cooking dinner this evening, I'm thinking about making something I've never made before. So, maybe Cortana can help me with the recipe. Hey Cortana. Find a recipe for Beef Wellington. Cortana: The first recipe is Beef Wellington, with 4.5 out of five stars on all recipes. It'll take one hour to make. 
Narrator: As far as Cortana settings, there are several aspects of using Cortana that are customizable. Let's go back to Cortana settings. Within Cortana settings, we can customize how we communicate with Cortana, set what applications and processes Cortana has access to, as well as review our Cortana history, link Cortana on Windows 10 with Cortana on other devices like smartphones, and learn about Cortana's privacy settings.
 If you need help with Cortana, there is a link for getting help in each of these sections. Cortana is Windows' digital assistant, packed with features that will help you work more efficiently and help you get things done.
Try it yourself
Challenge: Using the virtual assistant on your device, set a reminder for yourself to smile in 5 mi 
Discover various types of operating system accessibility features
2 minutes
Use accessibility features
Modern computers are designed with the needs of everyone in mind. There's no limit to who can use a computer. People with disabilities like limited vision or hearing can use them with the help of many built-in accessibility tools and features. Various programs can also be installed to add even more accessibility.
Watch the following video to learn about some of the accessibility features that are helpful for users of Windows 10 computers.
Video: Use accessibility features in Windows 10
There are a variety of accessibility features and tools that you can use with Windows10 to make it easier to use your computer, if you have certain disabilities or accessibility challenges. To use many of the accessibility features that come with your device, you often need to enable them first. You can access many of the Windows 10 accessibility features in the Settings app under ''Ease of Access''. 
First, we will cover Vision settings. For your display you can change the size of the application and texts you're viewing. To do so, click the drop-down menu here, and select the percentage that suits you. You can also change the brightness of the display and make it brighter. Moving down to cursor and pointer size, Windows 10 gives you the ability to change the size and color of the cursor to make it easier to see and use. Here, you can also change the width of the cursor to make it easier to find while typing. 
Next is Magnifier. Enable the magnifier feature to zoom in on parts of your screen as you use your computer. 
There are also Hearing settings. On your audio, you can set alerts to where your alerted visually. This prevents you from missing an audible alert. 
Under interaction, there are several settings based on your input, including speech, keyboard, and mouse. In the keyboard settings, there is an option to use an On-Screen Keyboard, which is very useful for devices without a physical keyboard. 
These are just a selection of the many features of Windows and other operating systems that improve accessibility and allow you to use your computer more effectively.
Knowledge check
4 minutes
 



1. Which of these functions is a task of an operating system?
· Managing computer hardware - Correct! This task is one of the functions of the operating system.
· Showing the user the working area
· Allowing the user to type
· Allowing the user to interact with the screen

2. An operating system is the most important ___________ on the computer.
· Hardware
· Software - Correct! An operating system is the software that manages all the other hardware and software.
· Peripheral device
· Application

3. What happens when you select the "Minimize" button at the top of an application window?
· The window closes
· The window hides until restored - Correct! The application is still working, and you can restore it.
· The window goes full screen
· The window moves to the side of the screen

4. In Windows 10, which menu of the Settings app manages the accessibility settings?
· Devices
· Network and Internet
· Ease of Access -Correct! This menu contains many accessibility features.
· Privacy

Summary
1 minute
Congratulations!
You have completed the Use a computer module and now can answer the following questions on your own:
1. What is an operating system? Provide an example of a popular operating system.
2. What are the primary parts of the operating system that you use to get things done?
3. How do files and folders help you organize things on your computer?
4. What does the right-click feature of an operating system help you do?
5. What parts of your operating system can you customize to your preferences?
Work with applications
12 minutes | 6 units
In this module, you will learn more about apps, what types of applications you can use, and how to work with applications on your computer.
Introduction
1 minute
Applications, also known as apps, are software programs that we can use to get things done on our computers. Every day, new applications are developed to solve new problems around the world.
In this lesson, you'll learn more about apps, what types of applications you can use, and how to work with applications on your computer.
By the end of this lesson you will be able to:
· Describe the concept of an application.
· Choose the right application for your needs.
· Understand the similarities between different applications.
· Work with applications on your computer.

Describe the concept of an application
2 minutes
What is an application
Applications are software programs that help us get things done on our computers. Every app is developed to help you get something done on your computer - like performing a calculation, editing a photo, or sending a message. There are many applications for you to choose from for different purposes.
Video: What is an application
Applications are software programs that help us get things done on our computers. Every app is developed to help you get something done, like performing a calculation, editing a photo, or sending a message. 
There are many categories of apps that you can use. More and more apps are being developed every day. From computer games, to studying apps, to communication apps, you can find an app to help you do almost anything on your computer. Some of these apps come pre-installed on your computer or phone with your operating system. If there is another app you want to use, you can download it and install it to your device. 
Different apps are made for different types of devices. Many software developers make mobile apps that you can install and run on smartphones on the go. Things like transportation apps, that let you track buses and trains, or time management apps, that send you reminders throughout the day, are great for mobile phones. 
Desktop apps run on desktop computers and usually have many more features than mobile apps because they run on bigger, more powerful computers. You can use desktop apps to do things like work on documents or even write code to build your own apps. 
There are also web apps that you can access online from any device that has a web browser. With so many apps out there, it’s easy to find the tools that you need to get things done on your computer.
Find the right application
3 minutes
Choose the right application
Choosing the right application for your needs is a skill that you can develop as you become more aware of the types of applications available and how to use them.
Watch the following video to learn how to choose the right applications for your needs.
Video: Choose the right application
Using your computer featuring the Windows 10 operating system, sometimes we may need to work and be productive, and sometimes we may just want to have fun. There are a variety of apps that we can use depending on what we need to do. Some apps come pre-installed on your computerlike Calculator or Notepad. But you can also install new apps on your computer. Using Windows 10, you can find and install apps from the Microsoft Store app. 
Let's open the Microsoft Store app. We can find it in your Start menu. If it isn't there, just type it in the search box. Apps can be found here in the apps section of the store. Think about apps as tools which fall into different categories. Featured apps will always appear at the top. There are bestselling apps, top free and paid apps, seasonal apps, et cetera. At the bottom, you can filter apps by category. Looking for an app so you can watch sports or keep up with your favorite teams? You can find it in the sports category. An app to help you manage your books or track your portfolio, you will find those apps in the personal finance category. 
For instance, Microsoft White board is an app I need on my computer for work. To install it on my computer, I just click on the app and then within the app page, click "Get". From there it will download and install the app on my computer, and then I'll be ready to work. 
Certain types of files require a certain type of application to open it. Notice, when we attempt to open a text file and select "Open with", we have a handful of text editing applications to choose from. If we look at a photo and select "Open with", we're presented with several applications to choose from to either view the photo or edit the photo. The "Open with" selection will be different depending on the file you're looking to open. 
Once you become familiar with the types of apps you can use on your computer, you will always have the tools you need to get things done.
Try it yourself
Open the Paint app on your computer. Explore the features of this app. What do you think you can use it for?
Understand the similarities between different applications
3 minutes
Working with applications
Most of the time that you spend on your computer, you will be working with applications. All applications share some features that make it easier to learn how to use new apps.
Watch the following video to learn more about working with applications in Windows 10.
Video: Working with applications in Windows 10
When working or playing on your computer, you will be using an application or an app. But what is an application? 
Applications are simply software programs on our computers that help us get things done. For instance, if you need to perform some quick calculations, you can use the Calculator, or if you want to draw something, you can do so in Paint. Although there are a variety of different apps, learning how to use them can be easy once you realize that most apps share common features. Let me show you. 
Let's open Paint. Notice there's an area at the top of the app called a ribbon. In the ribbon, there are tabs like File, Home, and View that will enable you to perform common functions within the app. Within the Home tab, you will be able to find Cut, Copy, and Paste, as well as how to change the size and color of text. In View, you will be able to zoom in and out as well as turn on and off rulers. 
Now, let's open Word. Notice that ribbon at the top? There, we can also find those same tabs and buttons. In Home, we can cut, copy, and paste as well as change the size and color of text. In View, we can zoom in or out as well as turn on and off rulers. If you are new to using these apps, always remember the ribbon at the top of the app is where you will usually find most of the functions you will need to use the app effectively. The ribbon and menu system might look slightly different in different apps, or if you're using an operating system other than Windows 10, but you'll still find similarities that can help you learn to use the app. 
Also, something very convenient about modern operating systems like Windows 10 is, you can have multiple apps open simultaneously. This is very helpful if you are working within several apps at once and need to go between these apps easily, or if you're like me and just don't like to close applications when you're done using them. Once you become familiar with the different apps on your computer and what you can accomplish when using them, there is no limit to what you can do.
Knowledge check
2 minutes
1. Which one is an operating system?
· Notepad
· Microsoft Word
· Microsoft Windows - Correct! Microsoft Windows is the most popular operating system.
· Paint

2. Which one is a function of an application?
· Managing computer hardware
· Managing computer software
· Allowing human control of the computer
· Doing quick calculations - Correct! A calculator is an application for doing calculations.

Summary
1 minute
Congratulations!
You have completed the Work with applications module and now can answer the following questions on your own:
1. What is an application, or an app?
2. What's the difference between an application and an operating system? How do they work?
3. What types of applications are there?
4. How can you learn to use new applications?

Work with connected devices
10 minutes | 5 units
In this module, you will learn how to use peripheral devices, portable storage devices, and Bluetooth devices.
Introduction
1 minute
Computers are built with the hardware that is necessary for the computer to operate at a basic level. However, there are times when you might want to add functionality to your computer by connecting an external device.
These types of devices are called peripheral devices. They add functionality to your computer by providing input functions and/or output functions. An example of an input device is a keyboard, which allows a user to type information, or a scanner, which allows a user to scan a photo into the computer. An example of an output device is a speaker that outputs sound from the computer to the user, or a monitor, which outputs visual information to the user.
In this lesson, you will learn how to connect peripheral devices to your computer.
By the end of this lesson you will be able to:
· Describe types of peripheral devices and their uses.
· Use portable storage devices.
· Connect Bluetooth devices to a computer.

Describe types of peripheral devices and their uses
3 minutes
Portable storage devices
Sometimes you need to enhance the storage abilities of your computer. You can connect portable storage devices like USB drives and external hard drives to your computer for additional storage. These devices also make it easy to transfer files from one device to another.
Watch the following video to learn more about portable storage devices.
Video: Connect a portable storage device in Windows 10
There may be times when you are using your computer and you realize that it may run out of storage space for all the documents photos or music you're storing. Or you may have a large file you'd like to share with a friend or family member nearby, but the file is too large to email. This is where portable storage devices like flash drives or portable hard drives can really come in handy. Both flash drives, also referred to as thumb drives, and portable hard drives connect to your computer inserting them into an open USB port on your computer. Usually, these are in the back of your computer, but there may be one or more USB ports on the front of your computer as well. 
Flash drives have a USB input built in. So, they are inserted into the USB port of your computer, while portable hard drives usually connect to your computer via a chord or wire into an available USB port. 
When you connect a portable drive to your computer, a File Explorer window will usually open displaying the contents of the portable drive. As you can see, your computer recognizes the portable drive and treats it like an additional hard drive on the computer. Like I mentioned earlier, these types of drives are perfect for storing access media or sharing a large file or files with someone else. 
Moving files to and from the portable drive is very simple. First, move the portable drive File Explorer window to one side of the screen. Then, open the folder where the file you'd like to share is located. 
My sister has given me a thumb drive and she would love to see the video I recorded of my son's first baseball game from earlier this season. So, I find that video in my FILES folder and just drag and drop it into the portable drive folder. Luckily for me, on her drive she has saved a video of my niece's latest violin recital. I can just select that file and drag it into my FILES folder to view later. Simple, right? 
Now, once we're done with the portable drive, we need to make sure to remove it from the computer properly. To do so, we simply right click on the portable drive in File Explorer and select "Eject". Windows tells me it's safe to remove the drive and I do so. You can use portable storage devices like thumb drives and portable hard drives to improve the storage abilities of your computer or transfer files to another computer with ease.
Describe types of peripheral devices and their uses
3 minutes
Bluetooth devices
With modern technology, we can connect peripheral devices to our computers without using cables. Bluetooth is a wireless technology that makes this possible. If a device is Bluetooth-enabled, you can connect it to a Bluetooth-enabled computer with the press of a button.
Using Bluetooth, you can connect wireless headphones to your computer and listen to music without plugging anything in or connect a keyboard to your computer without any cables. You can even connect both via Bluetooth at the same time.

Many laptops and tablets have Bluetooth support built in. If you're using a computer that doesn't have Bluetooth, you can plug a separate USB Bluetooth adapter into the USB port to enable Bluetooth.
Watch the following video to learn how to connect a Bluetooth device to your Windows 10 computer.
Video: Connect a Bluetooth device in Windows 10
Bluetooth is a wireless technology that allows devices to connect to your computer without cables. Many modern devices are Bluetooth-enabled, like wireless headphones, wireless mouse and keyboard devices, and wireless speakers. 
Let's walk through how you can connect a Bluetooth device to your computer using Windows 10. To connect the Bluetooth headset, speaker, or other audio device, first turn on your Bluetooth-enabled audio device and make it discoverable. The way you make it discoverable will depend on the device. If you're unsure of how to make it discoverable, check the device. Refer to device instructions or visit the manufacturer's website to learn how. 
Once your device is discoverable, turn on Bluetooth on your computer, if it isn't on already. To do this, select the Action Center in the bottom right of the desktop within the task bar, and select "Bluetooth." If you do not see the Bluetooth icon in the task bar, click the Start button, and select "Settings," "Devices, "then "Bluetooth and other devices". In the Bluetooth settings, turn on Bluetooth. Now, in the Action Center, select "Connect", and then find your device. 
Once you select your device, it will connect to your computer via Bluetooth. In the future, your device and your computer will usually automatically connect anytime the two are in range of each other, with Bluetooth turned on. If you have a Bluetooth keyboard, mouse, or other input device, turn the device on, and make it discoverable. 
Then, go into the Start menu, select "Settings," "Devices," then "Bluetooth and other devices". Click the plus button for "Add Bluetooth or other device", then select "Bluetooth", and then click on the device you wish to connect to your computer. Follow any additional instructions that may appear, and then click "Done". 
You can use Bluetooth to connect a variety of devices to your computer without using any cables or wires.
Knowledge check
2 minutes
1. You can use the portable storage devices to:
· Improve storage abilities of your computer.
· Transfer files from computer to another computer.
· Save a copy in a safe location.
· All of the above - Correct! Portable storage devices make storing and dealing with files easier.

2. These devices can be connected to a computer through Bluetooth technology except:
· Speakers
· Mouse
· Hard drive - Correct! A hard drive needs to be connected directly to a computer. This affects the speed of accessing stored files.
· Headphones

Summary
1 minute
Congratulations!
You have completed the Work with connected devices module and now can answer the following questions on your own:
1. What is the role of peripheral devices?
2. How can you increase the storage capacity of your computer using a peripheral device?
3. How can you connect a device to your computer wirelessly?
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2 minutes | 2 units
You must complete all of the modules in this course in order receive your certificate.
Receive credit
1 minute
Complete
Congratulations on completing Work with computers. Select Receive credit to complete the course and receive your certificate.
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